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Creating a Chart in Excel 2000 
By: Carole L. Colburn 

 
 To create a graph or chart, you must first enter headings into the spreadsheet. In 
this example, which comes partly from Make it with Microsoft Office, by Vickie Sharp, 
you will enter data to chart high school test scores.  
 
Entering Headings: 
 

1. Click in Cell B1 and type the word “Wentworth.” (No quotes are necessary) 
2. Press the Tab key. 
3. In Cell C1, type the word “Clayton” and press the Tab key again. 
4. In Cell D1, type the word “Meadows” and, again, press the Tab key. 
5. Type “Colburn” in Cell E1 and press the Enter key.  
6. Next, click in Cell A2 and type “Grade 10” and press the Enter key. 
7. In Cell A3, type “Grade 11” and again, press the Enter key. 
8. Now, in Cell A4, type “Grade 12.”  

 
 
 
Your spreadsheet should now look like this: 
. 

 
 

 



   

   
  

 
 
Now, you must enter the data you will create the chart from. 
 
Entering Data 
 
1. Click in Cell B2 and type “1400” and then press the Tab key. 
2. Next, in Cell C2, type “800” and press the Tab key again.  
3. Type “1100” in Cell D2, press the Tab key, and type “900” in Cell E2. Press the 

Tab key and then press the Enter key. 
4. Complete the rest of the data sheet using the following numbers. It should look 

like this when you are done. 
 

 
 
 
5. If you want to delete the content from a particular cell, click on that cell and press 

the Delete key on the keyboard. 
6. To undo what you did, use the Undo Button (it looks like the backwards pointing 

blue arrow) on the toolbar, or use the menu path Edit-Undo Typing.  
 

Creating a Chart 
 
Now it is time to create the chart. This chart will be embedded within the worksheet 
using the Chart Wizard. 
 
1. Select the cells you want to chart, by clicking first in Cell A1.  
2. Hold down the Shift key on the keyboard and while holding that key, click Cell 

E4. This should leave your spreadsheet looking like this: 
 



   

   
  

 
 
 
3. Next, either click the Insert menu and choose Chart or simply click the Chart 

Wizard Button.  
 

 
 

4. This will open the Chart Wizard dialog box.  
 

 



   

   
  

5. In Step 1 of the wizard, click the Custom Types Tab and under Chart Types 
select “Columns with Depth,” and then click “Next.” Clicking the Next button 
will open up Step 2 of the wizard.  
 

 
 

6. In Step 2 of the wizard, click the “Columns” Radio Button and click “Next” 
again. This will take you to Step 3.  

 

 

 



   

   
  

7. In step 3, click on the Legend Tab.  
8. Select Corner, and then click on the Titles Tab. Type “High School Test Scores” 

in the Chart Title field and then click “Next” again. 
 
 
 
 

 
 

 
 
 
 
 
 
 

 
 
 



   

   
  

 
9. Clicking “Next” will open step 4 of the wizard. This is the last step. In this dialog 

box you must choose whether you want to embed the chart within the 
spreadsheet itself (on the same sheet as the data) or place it in a separate sheet. 
Click “As object in” and then click Finish. 

 

 
 
 
 

Your chart should look something like this: 
 
 

 
 
 
 
 
 
 
 
 



   

   
  

To enlarge the chart, rest your mouse pointer over any of the corner “selecting 
handles” (the little black squares) until your pointer changes to a two-sided 
arrow. This is called the “resize” arrow.  Once you see the resize arrow, click, 
hold the click down, and drag to make the chart as large as you want it to be. 
**NOTE: Be very careful to drag slowly, as the resizing can get away from you! ☺  
Your chart might look better about this size: 
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A Message From the Network Administrator 
By: Paul Pominville 

 
Staff, 
  
As you logon to your computer an assortment of different functions are taking place.  This 
is our chance to install new software, apply operating system patches, and upgrade 
previously installed software.  Also, more importantly, this is when our anti-virus software 
gets updated.  Antivirus updates are released weekly and sometimes daily as needed.  
To this date more than 10,000 computer viruses have been identified, and 200 new ones 
are created every month.  At Howell Schools alone we catch twenty to thirty viruses daily 
attached to email messages being sent in from the outside and another 10 to 20 coming 
in from sources such as the web, floppy disks, and CDs.  If we neglect to logoff at night 
we are potentially leaving ourselves vulnerable to one of these new viruses! 
  
Here are a few tips to remember while you are working either here or at home. 
  
Never, ever: 

•         Open files or e-mail attachments from someone you don't know.  



   
•         Open files or e-mail attachments forwarded to you even if they are from 

someone you know.  

•         Open unsolicited or unexpected e-mail attachments until you've confirmed the 
sender actually meant to send them. 

•         Open a document with macros enabled, period.  

•         Boot from a floppy unless you personally created it, write protected it and stored 
it in a locked safe since then.  

If you fear your home computer may have been previously infected...check out this link.  
It contains a free online scanner that is up to date! 
  
http://www.antivirus.com/free_tools/ 
  
Thanks everyone and please...log off your computers at night. 
  
  
Paul Pominville 
Technology Department 
Howell Schools 

 
FYI: The HPS BIG BOARD was created for Howell Public Schools employees to use for advertising of 
personal items or business. If you have a house to sell, a dog that needs a new home or are looking for a 
someone to share a ride across the country, this is the place to advertise your needs. PLEASE DO NOT send 
these types of advertisements through regular e-mail methods.  
 
To access the BIG BOARD: 
 

1. From your folder list in Outlook, click the plus sign to the left of Public Folders. Then click the plus sign 
to the left of All Public Folders. This will expand the tree and allow you to view all folders. 

2. Double click on HPS BIG BOARD to open that folder. 
3. From here, you may post and” reply to” messages, just like you do in your own Inbox.  
  ***Note: You cannot delete messages from other people. You can only delete messages you have 
posted.  
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Lesson Plan of the Month 

The following lesson plan comes from:  http://www.remc11.k12.mi.us/bstpract/bstpract/097/097.pdf 

MAISA and the REMC Association of Michigan 
Best Practices in Technology Integration Plan 
 
Name: Janice Kesel 
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School District: Waverly Community School District 
School: Waverly High School 
Address: 5027 W. Michigan Avenue, Lansing, MI 48917 
 
Title: Internet Research Assistant 
Subject(s): Technology class or any class that uses research or the Internet 
Intended Grade Level(s): 9-12 
 
Description: 

Students are required to become Internet Research Assistants to a staff member or 
someone in the community and take that person on as a client. Students develop a letter 
informing potential clients that they are available to do research for them on any topic in which 
they may need information. The topic can be on a subject area (government, math); personal 
interest (vacations, golf courses); demonstration (use of a search engine or how to make a web 
page); or any area that the client specifies. After the client has filled in the research request form, 
the student starts the research portion. They must use various search engines and web sites and 
evaluate the material that they find. They gather their information in a variety of methods 
depending on the final product. They must also keep a careful record of “Works Cited” so that 
they document the source of their information. 
 

The students will present the information in whatever format has been requested. They 
may develop a cover letter and summarize their findings and answer the questions needed by the 
client; or actually “cut and paste” info from the net for the client; or bring in the client or a group 
and demonstrate the skills requested. Some students have videotaped their work as they research 
the quality of river water for a high school in Sweden that had requested information on this 
topic. In addition they located local resources on the Internet and emailed experts to get further 
information. The final products are varied. The students must evaluate their work and learning 
through journals that they email to the instructor. They must also meet with their clients for them 
to evaluate their products. 

 
Curriculum Benchmarks: 
MI.ELA.11. Define and investigate important issues and problems using a variety of resources, 
including technology, to explore and create. 
MI.ELA.11.HS.1. Generate questions about important issues that affect them or society, or topics 
about which they are curious; narrow the questions to a clear focus; and create a thesis or a 
hypothesis) 
MI.ELA.11.HS.2. Determine, evaluate, and use resources that are most appropriate and readily 
available for investigating a particular question or topic. 
MI.ELA.11.HS.3. Synthesize and evaluate information to draw conclusions and implications 
based on their investigation of an issue or problem. 
MI.ELA.11.HS.4. Research and select the medium and format to be used to present conclusions 
based on the investigation of an issue. 
MI.ELA.3. All students will focus on meaning and communication as they listen, speak, view, 
read, and write in personal, social, occupational, and civic contexts. 
 
In the State’s Technology Vision, there is a list that defines a technologically literate learner. 
Every one of those points is addressed in this assignment. 
• Students explore, evaluate, and use technology to accomplish, independently and 
cooperatively, real world tasks. 



   

   
  

• Students develop knowledge, ability and responsibility in the use of resources of technology. 
• Student acquire, organize, analyze, and present information 
• Students solve problems, accomplishes tasks, and expresses individual creativity; 
• Students apply legal and ethical standards 
 
The Benchmarks and Standards used are the following: 
Using an d Transferring 
Using Information Technologies 
Applying Appropriate Technologies 
Applying Standards 
 
Materials/Hardware/Software: 
• Access to the Internet and the World Wide Web through a browser 
• Use of various search engines 
• Use of a word processor or desktop publishing program or presentation program 
• Optional: Digital camera, video camera, laser printer, and scanner 
 
Activities/Procedures: 
 
1. Student information 
The purpose of being a Research Assistant is to use the research and evaluation skills the 
students have developed over the semester in an internet course Developing Independent 
Research Through Telecommunications (DIRTT) and apply them in a real life situation. The 
skills the students learn include the following: 
 
• Communication -Student/researcher s must contact a staff member/community member/client 
and establish a working client/researcher relationship with him or her. 
• Researching - Using the topic requested, the researcher uses various search engines to find 
information, answers, or solutions to assist his client. 
• Evaluation - The researcher must evaluate the web sites and the information to determine its 
validity before presenting the information to the client. 
• Presentation - Working with the client, the student/researcher must determine the best method 
for presentation. Often this takes the form of a cover letter, overview, and actual information 
taken from the site and a work-cited page. However, clients have also requested demonstrations 
to their classes or their groups. 
 
2. Client letter 
Sample client letter developed by a student: 
 
Personal Internet Research Assistance 
 
Dear Staff Members: 

Developing Independent Research Through Telecommunications (DIRTT) students have 
been learning how to research specific topics using the Internet as well as evaluate information. 
Part of the curriculum includes searching for information for you, the teacher. We are willing to 
research any topic. This includes school and personal life interests. We can find articles or web-
site addresses for you. 



   

   
  

 
We also would like to offer to share our knowledge. We will teach any class how to use 

the Internet, use email, or find web sites to research a topic of interest. Please contact us with any 
interests you may have. 

 
Sincerely, 
 
 
1997 DIRTT Classes 
 
 
Please fill out this form with your research request and return to 
Name: _________________________ Date:______________________ 
Topic(s) of interest:_________________________________________________ 
Date information wanted by:__________________________________________ 
Format of requested information:______________________________________ 
Additional information:______________________________________________ 
_________________________________________________________________ 
Student Research Assistant:_____________________ 
Completed by:____________________ 
Teacher's Signature__________________ 
 
3. Search Engines 
The following are some of the search engines used to find and explore for information: 
 
http://www.yahoo.com 
http://www.theFrontPage.com 
http://www.excite.com 
http://home.netscape.com/home/internetsearch.html 
http://guide-p.infoseek.com/Titles/ 
http://www.lycos.com/ 
http://www.mckinley.com/ 
http://altavista.digital.com/ 
http://www.webcrawler.com/ 
http://www.hotbot.com/ 
http://www.yahooligans.com/ 
http://galaxy.tradewave.com/cgi-bin/wais-text-multi? 
http://web.nexor.co.uk/public/aliweb/search/doc/form.html 
http://metacrawler.cs.washington.edu: 8080/ 
http://guaraldi.cs.colostate.edu: 2000/form 
http://www.albany.net/allinone/all1www.html 
http://www.search.com 
 
4. Products 
The product is the packet of information or the presentation that the researcher gives to his/her 
client. Students have produced web pages, videos, and oral presentations using LightPro and 
PowerPoint, as well as packets of information. The client and researcher determine the final 
format. 

http://www.yahoo.com/
http://www.thefrontpage.com/
http://www.excite.com/
http://home.netscape.com/home/internetsearch.html
http://guide-p.infoseek.com/Titles/
http://www.lycos.com/
http://www.mckinley.com/
http://altavista.digital.com/
http://www.webcrawler.com/
http://www.hotbot.com/
http://www.yahooligans.com/
http://galaxy.tradewave.com/cgi-bin/wais-text-multi?
http://web.nexor.co.uk/public/aliweb/search/doc/form.html
http://metacrawler.cs.washington.edu: 8080/
http://guaraldi.cs.colostate.edu: 2000/form
http://www.albany.net/allinone/all1www.html
http://www.search.com/


   

   
  

Some students have used elementary classes as their clients and taught them how to research a 
topic that they are studying in school, and others have used high school classes to teach them 
how to use the Internet, register for college and college scholarships, etc. The products have been 
individualized and specific to a task. 
 
Assessment/Evaluation: 
Students are evaluated by customer satisfaction. The student’s “client” will evaluate the product 
by filling in a form that rates the “researcher’s” completed product. The client may request 
follow up information and can receive assistance on his/her topic until they are satisfied. 
Students do a self-evaluation to determine what they have learned from this assignment, what the 
strengths and weaknesses of their plan are, the web sites used, the presentation used, and their 
research. 
Students email updates on their projects and share information and web sites of interest. So this 
is not just an individual project but also a collaborative effort. 
 
Follow-up Activities: 
Students may be requested to do further research by their clients or may select to do additional 
research on their own. Students have taken their research and created web pages with the 
information as well as created booklets to share their findings with other classes. 
 
 
 

***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  
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 Carole’s Training Corner  
Welcome to Spring! I think I can finally say that spring is here! I hope this finds everyone healthy and 
happy and enjoying the sunny and warmer weather. It is hard for me to believe that the end of the school 
year is approaching, and yet one look at the calendar tells me that it is so. I will be very busy during the 
month of May preparing for T4: Tomorrow’s Technology/Today’s Teachers, which will be offered again 

mailto:colburnc@howellschools.com


   
this summer. To find out more about this exciting technology integration opportunity, check out this web 
site: http://www.howellschools.com/~training/T4%20Home%20Page.htm 

I will also be visiting your buildings to offer “Simple Projects to Integrate Technology within a Lesson.” 
This session is meant to allow you to explore several different ideas for integrating technology into your 
lessons. IT is not a “How To” course, but rather a discussion about what you do already and an 
opportunity to brainstorm new ideas for incorporating technology within that spectrum. Look for dates I will 
be in your building at my web site: http://www.howellschools.com/~training/index.html 

Remember to keep smiling ~Carole ☺ 
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

SELECTING A LINE OF TEXT 

If you are new to Word, coming from using a different type of word processor, you probably 
noticed that there is no command in Word to delete a line of text. You can do this quickly by 
moving the mouse pointer to the left of the line of text you want to select. Don't move the mouse 
pointer into the style area (if you have the style area displayed), but just to the left of the first 
character in the line. The mouse pointer turns into an arrow pointing up and right. Click once on 
the left mouse button, and the entire line of text is selected. You are then able to do any other 
editing function on that line of text, including deleting it (by pressing DEL or CTRL+X). 

This tip applies to Word 6.0, Word 97, Word 2000 and Word 2002 
**
 
******************************************************************** 

HIDING ERRORS 
Word includes handy spelling and grammar checkers that can take the hard edges off some of your 
writing. Sometimes, however, it is nice to turn those features off so the red and green squiggly lines 
don’t distract you as you are feverishly typing your masterpiece. 
You probably already know that you can use settings on the Spelling & Grammar tab of the Options 
dialog box to hide both spelling and grammar errors. An easier way to turn errors on and off is to simply 
right-click on the Spelling and Grammar Status icon on the status bar. (This icon looks like an open book, 
sometimes with either a pencil or a red X over it.) When you right-click you can see a Context menu that 
allows you to turn error display on or off. 
 
This tip applies to Word 6.0, Word 97, Word 2000 and Word 2002 
********************************************************************** 
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ACCURATE FONT SIZES 
 
You already know that Word allows you to easily change the size of your 
fonts. You can use either the formatting toolbar or the Font dialog box 
(select Font from the Format menu) to set the size of type you have selected 
in your document. You may not know, however, that Word can use virtually any 
point size you want, not just those listed in the drop-down size lists. 
 
Font sizes are specified in points, which are a typographer's measurement 
roughly equivalent to 1/72 of an inch. You can either select a size from the 
drop down list, or you can enter your own size. Select the size shown in the 
list, and then type the size you actually want. When you press ENTER, the 
size of your selected text is changed. This is great when you want your text 
to be really large for special signs. For instance, you can easily set your 
font size to 120 or 200 points to make huge letters for a sign. 
 
It is also easy to overlook the fact that Word can display and print fonts in 
increments of half a point. Depending on the typeface being used, this can 
make a big difference. For example, there is a very marked difference between 
10 and 11 point Verdana, and 10.5 may be just what you need. 
 
You obtain the half-sizes by typing them directly into the size box. The 
half-sizes may not display accurately in Normal view, but they will in Print 
Layout view, and will print accurately. If you try to type in any other 
fractional size (like 10.25 or 10.4), Word displays an error message. You can 
only set full point sizes or half point sizes. 
 
********************************************************************** 

ENTERING TABS IN A TABLE 

When you are entering text in a table, some of the keyboard keys don't function as they do when you are 
working in the body of your document. One of those keys is the TAB key. If you press TAB, the insertion 
point moves to the next cell in the table, or if you are at the end of the table, it creates a new row. 
There may be times, however, when you want a tab character in the table's text. In order to insert a tab, 
you can use either of these methods: 

• Press CTRL+TAB.  
• Hold down the ALT key as you type 0009 on the numeric keypad.  

 
********************************************************************** 

FITTING YOUR INFORMATION IN AN EXCEL SPREADSHEET 

It is important to remember that the default size for Excel columns is only a 
starting point. In fact, one of the most common formatting tasks you will do 
in Excel is to adjust the width of columns. If you want to make sure that all 
the information in a cell is visible, try this: 
 
   1. Select a cell in the column you want to adjust, making sure you       

select the one that has the widest information you want displayed. 
   2. Choose Column from the Format menu. This displays a submenu. 
   3. Choose AutoFit Selection from the submenu. 
 
The column width is adjusted so that the information in the cell you selected 
is entirely visible. Another quick way to do a similar adjustment is to 



   

   
  

simply double-click on the divider bar between the column heading for the 
column you want to adjust and the column to the right. That may sound 
confusing, but it is really quite simple. For example, let's say you wanted 
to adjust the width of column D. All you need to do is double-click on the 
divider bar between D and E in the gray column headings at the top of the 
worksheet area. 
 
There is one difference between these two methods. If you use the AutoFit 
Selection method, the width is set based on the cell you have selected. If 
you use the double-click method, the width is set based on the widest item in 
the column, not what you have selected. 
 
********************************************************************** 
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Great “Springtime Crafts and Projects” Links For You to Try…     

 http://childparenting.about.com/cs/projects/ 

 http://www.homeschoolzone.com/pp/spring.htm 

 http://www.beritsbest.com/HolidaysSeasons/Spring/index.shtml 

 http://www.craftbin.com/projects/juniorbadges.htm 

 http://www.geocities.com/Athens/Thebes/9893/easterpage.html 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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